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ABOUT THIS GUIDE
The Web Management software is a suite of HTML-based applications 
that are shipped with the CoreBuilder® 9000 Enterprise Switch. This 
guide describes the applications, including an overview and information 
on installation and setup.

This guide is intended for network administrators who are responsible for 
managing 3Com switching devices with the Web Management tools.

If the information in the release notes that are shipped with your product 
differs from the information in this guide, follow the instructions in the 
release notes.

Most user guides and release notes are available in Adobe Acrobat 
Reader Portable Document Format (PDF) or HyperText Markup Language 
(HTML) on the 3Com World Wide Web site:

http://www.3com.com/

Conventions Table 1 and Table 2 list conventions that are used throughout this guide.

Table 1   Notice Icons

Icon Notice Type Description

Information note Information that describes important features or 
instructions

Caution Information that alerts you to potential loss of data or 
potential damage to an application, system, network, 
or device

Warning Information that alerts you to potential personal injury
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Year 2000 
Compliance 

For information on Year 2000 compliance and 3Com products, visit the 
3Com Year 2000 Web page:

http://www.3com.com/products/yr2000.html

Table 2   Text Conventions

Convention Description

Screen displays This typeface represents information as it appears on the 
screen.

Commands The word “command” means that you must enter the 
command exactly as shown and then press Return or Enter. 
Commands appear in bold. Example:

To remove the IP address, enter the following command:

ip interface remove

The words “enter” 
and “type”

When you see the word “enter” in this guide, you must type 
something, and then press Return or Enter. Do not press 
Return or Enter when an instruction simply says “type.”

Words in italics Italics are used to:

■ Emphasize a point.

■ Denote a new term at the place where it is defined in the 
text.

■ Identify menu names, menu commands, and software 
button names. Examples:

From the Help menu, select Contents.

Click OK.
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 WEB MANAGEMENT OVERVIEW
This chapter describes the components in the Web Management suite of 
applications for the CoreBuilder®  9000 Enterprise Switch. The chapter 
covers these topics:

■ Web Management Overview

■ Embedded Web Management Applications

■ Installable Web Management Help and Other Tools

■ Launching Web Management Applications

■ Logging Out

Figure 1 shows the opening Web Management screen.

Figure 1   Opening Screen of Web Management
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Web Management 
Overview

The Web Management suite of features consists of embedded Web 
Management applications and installable tools:

■ Embedded Web Management applications — Use the embedded 
Web Management applications, which are part of the system software 
image, for most of your device configuration and management tasks. 
You can manage a single port or device, or, using multiple windows, 
you can manage multiple devices. This software contains:

■ WebConsole — An HTML-based set of configuration forms. See 
“WebConsole Tab” on page 13 for details.

■ DeviceView — A Java-based application that displays a real-time 
image of the device. You can manage each port or module, or the 
entire system, by clicking the part of the image that you want to 
manage. See “Browser and Platform Requirements” on page 9 
and “DeviceView Tab” on page 16 for details.

■ Help access to the configuration form on which you set up the 
installable Help as well as access to links to support information on 
the 3Com Web site. (For how to install Help for the configuration 
forms, see Chapter 2.)

■ Installable tools — Install some or all of these optional tools on your 
workstation from the Software CD that is shipped with your system:

■ DeviceView accessories — To set up e-mail notification for 
Status Logging, as described in Chapter 2.

■ WebManage Framework — To group your access links to the 
devices that you manage, as described in Chapter 2.

■ Filter Builder — To create and test filters for packets on your 
switch. See “Filter Builder” on page 22 for details.

■ Form-specific Help — To access hypertext information about the 
fields in the WebConsole and DeviceView. See Chapter 2 for 
details.
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Browser and Platform
Requirements

The Web Management suite of applications has certain dependencies, as 
described in this section. 

Color Recommendations

The minimum graphics capability is SVGA (800x600 resolution). For best 
performance, use XGA (1024x768 resolution).

Browser Support

Web Management requires Microsoft Internet Explorer 4.01 or later OR 
Netscape Navigator 4.03 or later.

If you are using Netscape Navigator 4.03 or 4.04, be sure to install the 
Netscape JDK 1.1 Patch. Download the patch from this URL:

http://help.netscape.com/filelib.html#smartupdate

If you are using Internet Explorer, install the latest 4.01 Service Pack 1. 
This service pack makes Internet Explorer Year 2000-compliant and fixes 
other product support issues. Download the 4.01 Service Pack 1 from the 
following URL:

http://www.microsoft.com/msdownload/iebuild/ie4sp1_win32/en/
ie4sp1_win32.htm

If the link is not available, download the service pack from the Microsoft 
home page:

http://www.microsoft.com

See “Web Management and Internet Explorer” on page 31 and “Web 
Management and Netscape Navigator” on page 36 for more details.
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Platform Requirements

Table 3 lists the platforms that you need for each of the Web 
Management features.

Table 3   Platform Support for Web Management Features

Feature PC UNIX

Embedded Web Management Applications

WebConsole ✓ ✓
DeviceView ✓ ✓

Configuration form to set up Help, 
plus 3Com support links

✓ ✓

Installable Tools

Form-specific Help ✓ ✓

WebManage Framework, to 
customize your access to devices

✓

DeviceView accessories, such as 
e-mail notification for Status Log

✓

Filter Builder ✓
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Embedded Web 
Management 
Applications

You can access these embedded Web Management applications from the 
Tabs panel of the opening screen (Figure 2):

■ WebConsole (including configuration forms and wizards)

■ DeviceView

■ Help configuration form and 3Com support links 

Figure 2   Parts of the Web Management Opening Screen

Menu tree

Workspace

Tabs panel
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Interface Description The screen for the embedded Web Management applications is divided 
into three areas (Figure 2):

■ Tabs panel — At the top of the Web Management screen, the Tabs 
panel has three tabs: 

■ WebConsole tab — When you select this tab, the menu tree lists 
folders for the parameters that you can configure for the device to 
which you are connected. See “WebConsole Tab” on page 13 for 
details.

■ DeviceView tab — When you select this tab, you see an image of 
the device. You can configure some system and module 
parameters from this view. See “Browser and Platform 
Requirements” on page 9 for the required versions of Java-based 
browsers and “DeviceView Tab” on page 16 for details about the 
functionality of this view.

■ Help tab — When you select this tab, the menu tree lists the Help 
configuration form and several links to 3Com support sites. The 
menu tree also displays links to the Help Contents and Index. Until 
you install and configure Help, these links connect you to the Help 
configuration form.

To access Help for the forms, you must install and configure the 
supplemental Help files. See Chapter 2.

■ Menu tree — The menu tree frame at the left of the interface lists the 
menu options. Many of these options are the same as those found in 
the Administration Console command line interface. 

■ Configuration form icons — Click a folder to view the menu 
options, which appear as configuration form icons. Click a form 
icon to view the associated form in the workspace. See Figure 3.

■ Telnet icons — To configure system parameters that are not 
supported through the WebConsole, click a Telnet icon on the 
menu tree to launch a Telnet session to the Administration Console 
on the device. See Figure 3.

■ Workspace — The workspace frame of the interface displays the 
configuration form for the menu option that you select. See Figure 3.
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Figure 3   Using the WebConsole

WebConsole Tab In the WebConsole application, the menu tree of folders contains icons 
for options that you can change to manage your device. Click an icon to 
view the related configuration form.

Using the
WebConsole

To modify many of the parameters and attributes on your system, follow 
these steps:

1 In the menu tree, click the folder of the feature that you want to modify. 
See the menu tree in Figure 3. Example: Click IP. 

The expanded IP menu appears in the menu tree, showing the folders 
and form icons for the options with which you configure IP on your 
system.

2 Click another folder or the form icon for the feature that you want to 
configure. Example: Click Routing. 

The Routing configuration form appears.

Telnet icon
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3 To complete the form, type the required information. 

To get Help about a form and its fields, click the Help button at the 
bottom of the form. You must first have installed the form-specific Help; 
see Chapter 2.

4 Click Next or Next Bulk (on some forms) or Apply. 

■ Next displays an additional form with more fields where you enter 
information. 

■ Next Bulk allows you to specify more than one module or port before 
you continue the configuration. 

■ Apply implements the requested configuration. 

For some forms, you may need to reset the system for the changes to 
take effect.

5 To configure system parameters that are not supported through the 
WebConsole, click a Telnet icon (for example, Multicast) to launch a 
Telnet session to the Administration Console on the device, and then use 
the command line interface to configure the parameter. 

For details about the commands in the Administration Console, see the 
Command Reference Guide.
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Configuration Wizards

The WebConsole menu tree also contains icons for configuration wizards. 
Use a wizard to create valid configurations, modify attributes and 
parameters, and prevent common configuration mishaps. See Figure 4.

Using configuration
wizards

To use a configuration wizard, click the wizard icon and follow the 
instructions. The WebConsole contains these configuration wizards:

■ IP In-band configuration wizard — Helps you configure IP on a 
device.

■ Traffic policy configuration wizard (Layer 3 only) — Guides you 
through a high-level procedure for configuring traffic policies (Quality 
of Service) on the system. Most of the low-level details are changed 
internally.

■ Trunking wizard — Helps you define trunks on your system.

Figure 4   Opening Screen for a Configuration Wizard

Configuration
wizard icon
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DeviceView Tab The DeviceView application actively monitors the device so that you can 
configure parameters for the system, switch fabric modules, switching 
modules, and ports in an Internet browser. The live image in the 
DeviceView workspace allows you to monitor each element or the entire 
system in real time.

Using DeviceView 

To use the DeviceView application, on the Tabs panel on the Web 
Management opening screen, click the DeviceView tab to launch an 
image of the device and its installed components. See Figure 5. (See 
“Browser and Platform Requirements” on page 9 for information about 
setting up the JDK 1.1 Patch for certain browser versions.)

About the Device Image

To access a subset of the management options that are available through 
the WebConsole tab, click the device image (Figure 5). Table 4 lists the 
color codes that report the status of each element.

A blue border outlines the part of the device image under your pointer.

If you have installed the supplemental Help, click the Help button below 
the image for more information. See Chapter 2 for Help installation.

Table 4   Status Color Codes

Color/Shade Status

Green Enabled, link present

Partial shading (dark edge) Disabled, link present

Black Enabled, link absent

Gray shading Disabled, link absent

Red Partitioned, link present

Yellow Resilient, link absent
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Figure 5   DeviceView Image

Configuring Parameters in DeviceView

To configure a parameter for the system, for one of the installed 
components, or for a port, click the image of the area that you want to 
configure. Configuration forms appear in the DeviceView workspace. 

■ To view and modify system-level parameters, click anywhere along the 
outline of the chassis image, outside the module outline and power 
supply outline.

■ To view and modify module-level parameters, click the outline of the 
module that you want to configure. 

■ To view and modify port-level parameters, click the image of the port 
that you want to configure. 

■ To view and modify power supply parameters, click the image of the 
power supply that you want to configure. 
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Selecting Multiple Ports

To select multiple nonconsecutive ports for configuration in DeviceView, 
press and hold the Shift key and click the image of each port that you 
want to configure. To select consecutive ports, press and hold the Ctrl key 
while you click the first port and the last port in the series.

Using Status Logging

DeviceView has a Status Log that monitors system, component, and port 
changes on the device and displays the events in a log. See Figure 6.

Figure 6   Status Log in DeviceView

For Internet Explorer, you may want to follow the instructions to improve 
Status Logging functionality in “Improving DeviceView” in Chapter 3. 

You can set the Status Log to monitor the system, the modules, or the 
ports in any combination. To enable Status Logging options:

1 Select the DeviceView tab and then, in the menu tree, click DeviceView.

2 In the menu tree, click Configuration. 

The DeviceView configuration form appears. See Figure 7.
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Figure 7   DeviceView Configuration Form

3 In the Status Logging list box, select enabled. For other options, click 
Help.

4 Click Apply.

5 In the menu tree, click Status Log. 

The Status Log configuration form appears. 

6 Configure the options for sending e-mail messages about changes to the 
system, components, or ports. See Figure 8.

For information about the options, click Help.

To enable e-mail notices, if you have not installed the supplemental 
DeviceView accessories, install them now. See Chapter 2.

7 In the Status Log configuration form, click Apply.

For the changes to take effect:

■ In Netscape Navigator, reload the browser. 

■ In Microsoft Internet Explorer, refresh the browser window.

The Status Log now displays information about your mail server.
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Figure 8   Status Log Configuration Form

Help Tab The third tab of the Web Management opening screen contains these 
links:

■ The Help configuration form — When you install the Help, the links 
to the Help Contents and Help Index become active. If you have not 
installed the Help, these links connect you to the Help configuration 
form. See Chapter 2. 

■ Various 3Com support sites on the Web — Click a link to view the 
3Com contacts list, support page, and home page.



Installable Web Management Help and Other Tools 21
Installable Web 
Management Help 
and Other Tools

Download the installable Web Management tools from the Software CD 
that is shipped with your system. Using the installation wizard (described 
in Chapter 2), you can choose to install one or more of these tools:

■ WebManage Framework — To facilitate the way that you group 
and access devices and tools. See “WebManage Framework” next.

■ DeviceView Accessories — For e-mail notification for Status Log on 
DeviceView. See “Using Status Logging” on page 18 for details.

■ Filter Builder — To configure packet filters and test them before you 
load them on your device. See “Launching Filter Builder” on page 26 
for details.

■ Help — To learn more about each of the embedded configuration 
forms. You access this Help from the Help button on each form. See 
“Setting Up the Form-Specific Help Files” on page 29 for details.

WebManage
Framework

Use the WebManage Framework to organize the devices that you 
manage into easily accessible groups. For instance, you can create a 
folder for each group, using the configuration form in Figure 9.

Figure 9   Integrated WebManage Framework Window
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On the Devices tab:

■ To add a folder — In the Name box in the Add folder area of the 
form, type a meaningful name (such as Engineering-A  or 
Accounting-3 ), then click OK.

For best results, first create the folders and then create the link to each 
device.

■ To add a device — In the menu tree, click the folder in which you 
want to place the device. In the Name box of the Add device area, 
type a meaningful name (such as 9000-1 , 3900-3 , or 9000-16slot-1 ). 
In the IP box, type the IP address, then click OK.

■ To remove a device or folder — In the menu tree, click the folder or 
device name. In the Delete device or folder area, click OK.

Filter Builder You can use Filter Builder as a stand-alone application on your UNIX 
workstation or PC to create your own custom filters and save them as 
ASCII files. You then use the Trivial File Transfer Protocol (TFTP) to 
download the files that contain the custom filters to the switch. See the 
CoreBuilder 9000 Implementation Guide.

These Filter Builder functions that require an IP connection to the 
CoreBuilder 9000 are not supported in Release 3.0: 

■ Automatic filter downloads

■ Defining port groups

■ Assigning filters to ports, port groups, and paths on the switch 

To perform these functions, connect to the switch by clicking the Packet 
Filter Telnet icon and use the Administration Console command line 
interface. For details about the commands, see the “Packet Filters” 
chapter of the Command Reference Guide.
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Using Filter Builder To use the Filter Builder tool, select Custom or Typical in the Install Wizard 
installation. (See Chapter 2.) With Filter Builder, you can implement 
packet filters easily and verify that your filters are syntactically correct 
before you load them on your 3Com device. You can use one of the 
predefined filters included with Filter Builder, or you can create a new 
one.

To distinguish predefined filters from filters that you create, look at the 
icon for each filter’s name in the list on the Filter tab. The icon for 
predefined filters has a lock in the lower left corner, which indicates that 
the filter is write protected; that is, you cannot edit or delete it.

Although predefined filters are write-protected, you can change a 
predefined filter indirectly by copying it, giving it a new name, and then 
editing it.

Access Filter Builder in either of these ways:

■ If you have installed both WebManage Framework and Filter Builder, 
start WebManage and then, on the Tools tab, click Filter Builder.

■ If you have installed Filter Builder but not WebManage Framework, 
find Filter Builder on your hard drive and double-click the icon.

Figure 10 shows the Filter Builder configuration form.

Figure 10   Filter Builder Configuration Form
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Filter Builder includes 10 predefined filters, which are listed on the Filter 
tab of the WebManage Framework. Table 5 lists the predefined filters and 
what each does.

Creating a filter To create a filter, use one of Filter Builder’s two interfaces:

■ Filter Wizard window — Use this interface if you are unfamiliar with 
packet filtering or to create a simple filter.

■ Create or Edit Filter window — Use this interface if you are familiar 
with packet filtering or to create a complex filter.

For additional information about Filter Builder, see these resources:

■ Filter Builder User Guide

This guide is in the software directory in Portable Document Format 
(PDF) on the Software CD.

■ Filter Builder Help System

Filter Builder has a comprehensive Help system that is accessible from 
the Help menu on WebManage Framework and from Help buttons 
within the Filter Builder application. The Help system includes “What’s 
This?” Help, with which you can access Help information about 
individual screen icons, buttons, and fields.

Table 5   Predefined Filter Builder Packet Filters

Filter Name Filtering Job

fddiforwardip Forwards FDDI IP, ARP, and RARP packets

forwardethernetip Forwards Ethernet IP, ARP, and RARP packets

rejbroadcast Rejects packets from a specific address group

rejdiffaddgrp Rejects packets from a specific address group

rejdiffportgrp Rejects packets from a specific port group

rejethernetappletalk Rejects Ethernet AppleTalk packets

rejethernetipx802 Rejects Ethernet IPX packets

rejfddiat Rejects FDDI AppleTalk packets

rejfddiipx802 Rejects FDDI IPX packets

rejmulticast Rejects multicast packets
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■ CoreBuilder 9000 Release Notes for the management modules, 
Layer 2 switching modules, Layer 3 switching modules, or switch 
fabric modules and I/O interface modules

Any system issues or known problems related to Filter Builder are 
listed among the Web Management system issues and Web 
Management known problems in the release notes that are shipped 
with your product. 

■ CoreBuilder 9000 Implementation Guide

The CoreBuilder 9000 Implementation Guide contains detailed 
information about the packet filter language.

Help Files Each configuration form has a Help button and one or more related Help 
topics. See Figure 11. Many Help pages have additional links, including a 
link to the HTML version of the CoreBuilder 9000 Implementation Guide. 

The banner at the top and the row of links at the bottom of each Help 
page provide access to the Start page (containing Web Management 
overview information), Contents, Index, Technical Support, and the 3Com 
Corporation home page.

See Chapter 2 for installation and Help configuration instructions.

Figure 11   Help Page

 

Additional
links

Help
banner 
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Launching Web 
Management 
Applications

Depending on which optional files you decide to install, you can:

■ Manage a single device.

■ Access Help from each form.

■ Use WebManage Framework to organize your access to multiple 
devices.

■ Enable e-mail notification of Status Log events.

■ Use Filter Builder.

Managing a
Single Device

To use the embedded Web Management applications, you do not need 
to install any of the optional files. Open a new Internet browser window 
on your workstation and enter the IP address of the system that you want 
to manage. The Web Management opening screen appears, with the 
WebConsole, DeviceView, and Help tabs. (Use the Help tab to configure 
the location of your Help files.)

Launching the
Form-specific Help

If you have installed and configured Help (Chapter 2), access Help from 
the Help button for each form as you manage your device, or use the 
Contents and Index links on the Help tab to search for information about 
a topic.

Launching the
WebManage

Framework

If you have installed WebManage Framework, from the Windows 95 or 
Windows NT Start menu, point to Programs, and then WebManage, and 
then select WebManage.

Enabling E-mail
Notification for

Status Log

If you have installed DeviceView Accessories, see “Using Status Logging” 
on page 18 for instructions about how to configure your device to send 
e-mail notification of Status Log events in the DeviceView application.

Launching Filter
Builder

If you have installed Filter Builder, from the Windows 95 or Windows NT 
Start menu, point to Programs, and then WebManage, and then select 
Filter Builder.

Logging Out To disconnect a session from Web Management, close the browser 
window or enter another IP address.
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 INSTALLING AND SETTING UP THE 
INSTALLABLE TOOLS
This chapter covers installation and setup for the additional tools that you 
can install locally to help manage your system. The chapter covers:

■ Installing Supplemental Tools

■ Setting Up the Form-specific Help Files

Installing 
Supplemental Tools

The supplemental tools come with your product on the Software CD. Use 
the installation file webmanagev30.exe  to launch the installation 
wizard.

Windows Installation If you decide to install the additional Web Management files on a PC, 
copy them to a workstation that runs Windows 95 or Windows NT or to 
an NT server.

To download the installable Web Management tools:

1 Close all open programs and applications.

2 In the CD directory, locate the webmanagev30.exe  file.

3 Double-click the file and follow the instructions in the installation wizard. 
Select one of these three types of installation: 

■ Custom — Installs one or more supplemental Web Management 
components that you select from a checklist.

■ Help Files Install — Installs only the Help files for the Web 
Management embedded forms. You can select which of five 3Com 
switching product’s Help files you want to install.

■ Typical — Installs all supplemental Web Management components, 
including the WebManage Framework, Filter Builder, DeviceView 
accessories (such as Status Logging), and the Help files for five 3Com 
switching products.
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If you plan to group multiple devices in easily accessible folders, select the 
Typical installation or select the WebManage option in the Custom 
installation.

4 Decide whether to reboot:

■ If you have selected Help Files Install or Typical and are using 
Windows  95, the wizard prompts you to confirm whether you want 
to reboot your system. If you click Finish, the system reboots to 
complete the installation process. 

If you are running Windows NT, you do not need to reboot the system.

■ If you have selected the Custom installation and installed only the 
Help files, you do not need to reboot your system. 

The installation wizard installs the Web Management icon in the directory 
that you specified in step 3.

5 To configure your Help files, follow the instructions in “Setting Up the 
Form-specific Help Files” on page 29. 

6 To launch your applications, see Chapter 1.

UNIX Help
Installation

A UNIX .TAR file that contains the Web Management Help system is 
available on the Software CD. 

To install Help files on your UNIX workstation:

1 Locate the HELP.TAR file on the CD.

2 Extract the .TAR  file into your Web server directory using the tar -xvf 

HELP.TAR command.

3 To configure your Help files, follow the instructions in “Setting Up the 
Form-specific Help Files” on page 29. 

4 To launch Help, see Chapter 1.
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Setting Up the 
Form-specific Help 
Files

To access Help, install the Help files on your workstation using Help Files 
Install or Typical in the installation wizard. See “Windows Installation” on 
page 27 or “UNIX Help Installation” on page 28.

The first time that you access Help, the system displays the Help 
configuration form.

To configure the location of the Help files: 

1 In the banner of the Web Management opening screen, select the Help 
tab.

The Help Server configuration form appears.

2 In the Help Installation URL box of the form, type the URL for the Help 
files. 

Follow the examples in the Help Server configuration form in Figure 12.

Do not end the URL with a slash (/). 

Figure 12   Help Server Configuration Form
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3 Click Apply. 

The system displays a message that the configuration has been 
successful.

4 To link the Help to Web Management on the WebConsole opening 
screen, select any item in the menu tree and then click the Help button 
on the form.

Help is now configured for your system. 

5 To access Help on any form, click the form’s Help button. 

6 To access the Contents of the Help system:

■ Click the Help tab on the Web Management opening screen.

■ Click Contents at the top or bottom of each Help page. 

See Figure 11 in Chapter 1.

The banner at the top of each Help page and the row of links at the 
bottom of each Help page provide access to the Start page (containing 
Web Management overview information), Contents, Index, Technical 
Support, and the 3Com Corporation home page.



3
 TROUBLESHOOTING
This chapter covers the following topics:

■ Browser Issues

■ Troubleshooting the Web Management Software

Browser Issues In addition to the tips in this section, see these sources of information:

■ “Browser and Platform Requirements” in Chapter 1

■ The sections on system issues and known problems for Web 
Management in the release notes that are shipped with your product

■ The Web Management readme file on the Software CD

Web Management
and Internet Explorer

If you are using Microsoft Internet Explorer, install the latest 4.01 Service 
Pack 1. This service pack makes Internet Explorer Year 2000-compliant 
and fixes other product support issues. Download the 4.01 Service Pack 1 
from the following URL:

http://www.microsoft.com/msdownload/iebuild/ie4sp1_win32/en/
ie4sp1_win32.htm

If the link is not available, download the service pack from the Microsoft 
home page: 

http://www.microsoft.com
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Improving
DeviceView

Certain Status Log options allow you to send e-mail messages regarding 
system, module, and port status changes to one or more e-mail 
addresses. To access these e-mail options, install the additional Web 
Management tools and enable Status Logging. See Chapter 2for 
information about installing the supplemental tools.

Improving DeviceView Download Speed

To improve download speed for DeviceView image in Internet Explorer, 
you change several security settings:

1 Open an Internet Explorer browser window.

2 From the View menu in the browser window, select Internet Options. 

The Internet Options dialog box appears.

3 To view security options, select the Security tab. See Figure 13.

Figure 13   Security Tab on the Internet Options Dialog Box



Browser Issues 33
4 In the Zone list box, select Trusted sites zone. 

5 Click the Add Sites button.

The Trusted sites zone dialog box appears. See Figure 14. 

6 In the Add this Web site to the zone box, type http://  plus the IP 
address of the device that you want to manage through Web 
Management. Example:

http://158.101.81.1

This information is added to the Web sites box. 

Clear the Require server verification (https:) for all sites in this zone check 
box.

7 When you have added all of the devices that you want to manage, click 
OK. 

Figure 14   Trusted Sites Zone Dialog Box
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Enabling Status Log E-mail Options on Internet Explorer

To ensure that the e-mail option for Status Log is available, follow the 
steps in “Improving DeviceView” on page 32 and then take these steps:

1 In the Internet Options dialog box, select the Security tab and then, to set 
custom security settings, click the Custom option button. 

The Settings button to the right of this option is now available 
(Figure 13).

2 Click Settings. 

The Security Settings dialog box appears (Figure 15).

3 In the Reset to: list box, select Low security and click Reset.

4 In the Security Settings area, scroll down to Java permissions and select 
the Custom option button. 

The Java Custom Settings button at the bottom of the dialog box is now 
available.

Figure 15   Security Settings Dialog Box
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5 Click Java Custom Settings.

The Trusted sites zone dialog box appears. See Figure 16. 

6 Select the Edit Permissions tab.

If you cannot configure the options that are listed under Unsigned 
Content, verify that you are using the latest version of Internet Explorer.

Figure 16   Edit Permissions Tab

7 In the Run Unsigned Content choices, click the Enable option button.

8 To close the Trusted sites zone dialog box, click OK. To close the Security 
Settings dialog box, click OK.

9 To apply the setting, in the Internet Options dialog box, click Apply. To 
close the Internet Options dialog box, click OK.
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Web Management
and Netscape

Navigator

If you encounter problems accessing Help files from Filter Builder or from 
other Web Management applications when you use Netscape Navigator, 
clear the browser memory cache and disk cache and restart the browser.

To clear the cache in Netscape Navigator:

1 In the browser window, from the Edit menu, select Preferences. 

2 In the Category menu tree, select Advanced and then, in the Advanced 
folder, select Cache.

The browser cache options appear to the right of the menu tree.

3 To clear the memory cache and disk cache, click the appropriate buttons 
on the cache options form.

4 Restart the browser.

If the Netscape browser does not close, press Ctrl+Alt+Delete and end 
the Netscape browser task.

Troubleshooting 
the Web 
Management 
Software

If you are unable to run the Web Management software, verify the 
accuracy of your CLASSPATH environment variable.

By default, the Web Management installation adds two directories above 
your existing CLASSPATH: C:\3Com.

Your directories may be different if you did not select the default 
C:\3Com directory during installation.

If your system already has an existing CLASSPATH before you install the 
additional Web Management files, the necessary 3Com directories are 
added above yours. As a result, your classpath may look like this:

C:\3Com;C:\java\classes;C:\java\applets\myclasses;

If you modify your classpath and do not include the 3Com directories 
(and possibly if you do not list them before any other directories in your 
classpath), the Web Management components may fail to run properly.

In Windows 95, your CLASSPATH is set in the autoexec.bat  file. It usually 
appears in this format:

SET CLASSPATH=C:\3Com;
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In Windows NT, your CLASSPATH is set through the System icon in the 
Control Panel. If you do not know how to change your environment 
variables, ask your system administrator.

Examples of Good
and Problematic

CLASSPATH Settings

This minimal setting is required for Web Management:

SET CLASSPATH=C:\3Com;

The following setting is also acceptable:

SET CLASSPATH=C:\3Com;C:\java\classes;

This setting can potentially cause problems:

SET CLASSPATH=C:\java\classes;C:\myclasses;C:\3Com;

The next setting results in unspecified behavior, because certain 3Com 
Web Management directories are not included. An unspecified 
CLASSPATH has similar results. In either case, the installed Web 
Management applications may fail to run:

SET CLASSPATH=C:Local Status Log

Additional Resources
for Solving Problems

If you still encounter problems after you try the tips offered in this 
chapter, consult these sources of information: 

■ Any Web Management system issues and Web Management known 
problems in the CoreBuilder 9000 Release Notes for the management 
modules, Layer 2 switching modules, Layer 3 switching modules, and 
switch fabric modules and I/O interface modules.

■ Your network supplier

■ The Technical Support appendix in the release notes
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